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Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
MPLAB® Code Configurator V3.xx. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Website

• Development Systems Customer Change Notification Service

• Customer Support

• Revision History

DOCUMENT LAYOUT

This document describes how to use the MPLAB® Code Configurator V3.xx. The 
document is organized as follows:

• Chapter 1. “Overview” – This chapter provides a description of the MPLAB® 
Code Configurator and basic information about its use.

• Chapter 2. “Operating Areas” – This chapter contains the listing and description 
of the main operating areas of the MPLAB® Code Configurator.

• Chapter 3. “Generating MCC Drivers” – Consult this chapter to find out how to 
generate peripheral drivers using the MPLAB® Code Configurator.

• Chapter 4. “Generated Sources and Header Files” – This chapter provides 
information about the generated drivers. 

• Chapter 5. “MCC Device Migration”

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2016 Microchip Technology Inc. DS40001829B-page 4



Preface
CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

 2016 Microchip Technology Inc. DS40001829B-page 5



Preface
RECOMMENDED READING

This user’s guide describes how to use Microchip’s MPLAB® Code Configurator V3.xx. 
For more information on the MPLAB® Code Configurator V3.xx, refer to the link below:

http://www.microchip.com/mcc

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. Acces-
sible by using your favorite Internet browser, the website contains the following infor-
mation:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip website at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers, assemblers, linkers 
and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM™ assembler); all MPLAB linkers (including 
MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object 
librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3 
debug express.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART® Plus and 
PICkit 2 and 3.
 2016 Microchip Technology Inc. DS40001829B-page 6
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Preface
CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the website at: 

http://www.microchip.com/support

and 

http://www.microchip.com/forums.

REVISION HISTORY

Revision A (January 2016)

Initial release of the document.

Revision B (May 2016)

Revise Figure 1-1; Revise Chapter 2; Revised Figure 2-5 Title; Add Figures 2-6 through 
2-10; Revise Chapter 3.
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Chapter 1. Overview
1.1 INTRODUCTION

The MPLAB® Code Configurator (MCC) generates driver code using a Graphical User
Interface (GUI). The generated drivers control the peripherals on PIC® microcontrollers.
The GUI provides an easy means for setting up the configuration of the peripherals. The
MCC is a plugin for the MPLAB X IDE. 

Additionally, the MCC is used to configure and generate libraries, which allows the user
to configure and generate code for software libraries and off-chip peripherals. 

The generated drivers or libraries can be used in any Microchip PIC device application
program. The MCC requires a MPLAB X IDE project to be created, or an existing
project opened, before launching the MCC plugin. This is necessary as the MCC needs
to know the device used in the project, to have access to device-specific information
like registers, bits and configurations and to set up the MCC GUI. 

The MCC generates source and header files based on selections made in the GUI. The
generated files are added to the active project of MPLAB X IDE. 

Figure 1-1 shows an overview of working of the MCC for generating peripheral drivers
or libraries.
 2016 Microchip Technology Inc.   DS40001829B-page 8



Overview
FIGURE 1-1: WORKING OF MPLAB® CODE CONFIGURATOR
 2016 Microchip Technology Inc.   DS40001829B-page 9
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Chapter 2.  Operating Areas
2.1 OVERVIEW

The MCC user interface consists of three main operating areas, as shown in
Figure 2-1. 

1. Resource Area: This area displays the MCC supported on-chip peripherals,
libraries, and off-chip peripherals that are available for the selected device. The
Resource Area includes project resources selected for the project, the device
resources showing the available resources and the available MCC library
versions on the local machine. 

2. Composer Area: This area is the main area in which a peripheral or library driver
can be configured. This area provides the user with an interface to configure the
peripheral or the library driver. 

3. Pin Manager Area: in this area the I/O pins of the device can be configured. The
Pin Manager Table View provides an interface for configuring the device pins.
This area also displays the pins in a Package View, showing the pin out of the
device and the functions assigned to the pins.
 2016 Microchip Technology Inc. DS40001829B-page 10
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FIGURE 2-1: MCC WITH DIFFERENT OPERATING AREAS



Operating Areas
2.2 RESOURCE AREA

The Resource Area is further divided into three sub-windows: 

1. Project Resources Area

2. Device Resources Area

3. Versions Area

2.2.1 Project Resources Area 

The Project Resources Area (Figure 2-2) displays the list of on-chip and off-chip
peripherals, and libraries that have been configured for the MCC project. The
peripheral and libraries are added to the project by selecting them from the Device
Resources Area. To add a peripheral or library to the Project Resources Area,
double-click on its name in the Device Resources Area. The corresponding user
interface gets displayed in the Composer Area from where the selected module can be
configured.

A module in the Project Resources window can be removed from the project by clicking
the X button to the right of the module name in the Project Resources Area. The module
will be removed from the MPLAB X IDE project. When a module is removed from the
Project Resources, all of the configuration information for that module is lost.

There are three system modules that are always available in the Project Resources
Area. These modules cannot be removed. The modules are:

1. Interrupt Module: configures the interrupts for the device.

2. Pin Module: configures the pins for the device.

3. System Module: configures the system clock, Configuration bits, and other
device-level functions for the device.

FIGURE 2-2: PROJECT RESOURCES AREA

2.2.2 Device Resources Area 

The Device Resources Area (Figure 2-3) lists data sheet, on-chip and off-chip peripherals
and libraries supported by MCC for the device configured in the MPLAB X IDE project.
These items can be added to the MCC Project Resources Area. When the name of a
peripheral or library is double-clicked, it is moved from the Device Resources Area, to
the Project Resources Area. 

 

Note: The Documents section of the Device Resources Area provides a link to the 
data sheet of the selected device on www.microchip.com.
 2016 Microchip Technology Inc. DS40001829B-page 12
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Operating Areas
FIGURE 2-3: DEVICE RESOURCES AREA

The Device Resources tree shown in Figure 2-3 can also be navigated and handled by
using the following keys:

1. Up and down arrow keys: for moving up and down in the tree, respectively

2. Right arrow key: for expanding a node

3. Left arrow key: for collapsing a node

2.2.3 Versions Area

The Versions Area provides information about the versions of the component groups 
that make up MCC. These component groups are called “Libraries”. Over time, multiple 
versions of the Libraries may be available. In the Versions Area, MCC can be config-
ured to use a specific version of a Library for the current MCC project.
 2016 Microchip Technology Inc. DS40001829B-page 13



Operating Areas
FIGURE 2-4: VERSIONS AREA

- A red dot means that the version of the library is not compatible with the ver-
sion of the core installed.

- A grey dot means that the version of the library is compatible but is not loaded 
in the device resources.

- A green dot means that the version is compatible with the core and is loaded 
in the device resources.

To load a compatible version of the library in the device resources, the user needs to 
invoke the context menu and select “Mark for Load” for the specific library and then hit 
Load Selected Libraries button in Versions Area.

2.2.3.1 ADDING LIBRARIES TO MCC

The user can download the library from the MCC website and load it to MCC in MPLAB 
X.
 2016 Microchip Technology Inc. DS40001829B-page 14



Operating Areas
FIGURE 2-5: LIBRARIES

1. Choose where you have downloaded the library; it should be a .jar file. (If you 
have downloaded from the website, it might be in .zip format, which would need 
to be unzipped).

2. Using the “Open Library folder”, copy the library into that location.

3. Restart MCC.

4. The newly added library should appear in the Versions Area.

2.3 PIN MANAGER AREA 

The Pin Manager Area consists of the following two sub-areas: 

1. The Package or Graphical View, which shows a graphical representation of the
package selected for the device (Figure 2-6). 

2. Table View, which shows a tabular form of the Pin Manager (Figure 2-8). I/O pins
of the selected device can be configured from these windows.

 

Note: In addition to the Pin Manager Area, additional pin configuration is provided 
by the Pin Module in the Composer Area. When the Pin Module is selected 
in the Project Resources Area, the Pin Module View is shown in the 
Composer Area.
 2016 Microchip Technology Inc. DS40001829B-page 15



Operating Areas
The following color combinations are associated with the pins in Graphical or Table
View: 

1. Gray colored pin: indicates that the pin is not usable in the selected configuration
and that there is no enabled module which has any functionality on that pin.
There are also grayed out locks on a white background that indicate pins that are
locked out by selected system functions.

2. Blue colored pin: indicates pins that are available to be allocated to a module. 

3. Green colored pin (with a lock): this combination indicates that the pin has been
allocated and selected for a module. The name displayed against the pin is either
the name of the pin in the module’s context or a custom name entered.

4. Green color pin (with chain link): this combination indicates that the pin is shared
between multiple functions. 

5. Yellow colored pin: indicates a possible alternate pin for an already allocated pin
function.

6. Grayed out locks on a white background indicates pins that are locked out by 
selected system functions.

2.3.1 Package View 

The graphical Pin Manager can be zoomed in and out in order to adjust its visibility. This
can be done by scrolling the mouse wheel when the mouse is over the Package View.
Zooming can also be achieved by the “+” and “-” keys on the keyboard (useful if the
mouse is not available).

FIGURE 2-6: PACKAGE VIEW OF PIN MANAGER

2.3.2 Table View

In the Table View sub-area, the device package can be selected from a drop-down list.
The package selection is in the upper left side of the Pin Manager Table View. In
Figure 2-7, the drop-down list shows that the TQFP44 package has been selected.

The selected package will be displayed in the Package View. The pin numbers in the
Table View will also show the pin numbers for the selected package.
 2016 Microchip Technology Inc. DS40001829B-page 16



Operating Areas
FIGURE 2-7: TABLE VIEW OF PIN MANAGER (MCC V3.00 AND EARLIER)

The three leftmost columns in the Table View indicate the module’s name, functionality
name and the direction, respectively. 

The Table View or the Package View can be exported using the Export button. It is used
to save the Package or the Table View to an image file. The supported image format is
.png.

FIGURE 2-8: TABLE VIEW OF PIN MANAGER 

The Table View allows you to:

- Expand/collapse rows and ports (Figure 2-9)

- Hide and show ports and rows (Figure 2-9 and Figure 2-10)

- Show only the pins that are configured (Isolate) (Figure 2-11)

FIGURE 2-9: COLLAPSING PORTS AND ROWS
 2016 Microchip Technology Inc. DS40001829B-page 17



Operating Areas
FIGURE 2-10: HIDING PORTS AND ROWS

FIGURE 2-11: RESTORING PORTS AND ROWS (SHOW ALL)

FIGURE 2-12: ISOLATING THE SELECTED PINS
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Operating Areas
2.3.3 Pin Module View

For any pin which has been configured in the Pin Manager Table View, additional
configuration of that pin can be done using the Pin Module View in the Composer Area.
To display the Pin Module View, click on the Pin Module in the Project Resources Area
(Figure 2-13).

FIGURE 2-13: PIN MODULE VIEW OF PIN MANAGER
 2016 Microchip Technology Inc. DS40001829B-page 19



Operating Areas
2.4 COMPOSER AREA

When a peripheral or library is selected from the Project Resources Area, its
corresponding configuration GUI is displayed in the Composer Area. The Composer
Area (Figure 2-14) is where peripherals and libraries are configured based on the
application’s requirements.

After completing the configuration of the peripheral, clicking the Generate Code button
will generate drivers for all of the peripherals and libraries configured for the device.

2.4.1 The Easy Setup Tab

FIGURE 2-14: COMPOSER AREA FOR UART MODULE

If the UART1 peripheral is selected from the Project Resources Area, the UART1
Composer Area is displayed.

The Easy Setup tab in the UART Composer Area allows configuring various UART
parameters related to the transmission and the reception operations.

2.4.2 The Registers Tab

In addition to the Easy Setup tab in the module’s Composer, MCC v3.00 also provides
a Registers tab (Figure 2-15). The Registers tab provides direct access for the user
to configure the module’s registers and settings. The Easy Setup tab allows
configuration of the common usages of the modules. The Registers tab allows the user
unrestricted access to the configuration of the module.

Any module configuration done using the Easy Setup tab will be reflected in the values
displayed in the Registers tab. Likewise, changes performed in the Registers tab, will
be reflected in the values in the Easy Setup tab.
 2016 Microchip Technology Inc. DS40001829B-page 20



Operating Areas
FIGURE 2-15: REGISTER VIEW

2.4.3 The Notifications Tab

The notifications in the Composer View show details and hints for all the modules that
are being selected in the Project Resources window. 

The Notifications tab (Figure 2-16) has four columns: category, module name, type,
and description. 

1. Category: identifies the notification as an alert or information that the module
depends on another module. 

2. Module Name: is the name of the module that generated the notification. 

3. Type: indicates the severity of the notification.

- Hint: this provides information to assist in the successful configuration of the
module. The module and the MCC can still be used. Action might be required. 

- Info: information only, no action is required. 

Note: The notification type may change as the user changes the configuration of 
MCC. For example, “Warning” might indicate that a module requires 
another module to be added to the project to operate correctly. After the 
module is added, the notification type would change to “Info”. 

Note: Notifications with a type of “Warning” or “Error” indicates that MCC code 
generation may fail, or that the generated code may not operate as 
intended when it is loaded on the target device. 
 2016 Microchip Technology Inc. DS40001829B-page 21



Operating Areas
FIGURE 2-16: NOTIFICATIONS TAB IN COMPOSER AREA

The MCC configuration is saved to the disk when the Generate button is pressed, or if
the MPLAB X IDE Save button is clicked.

An existing MCC configuration file can be loaded by double-clicking on the desired
.mc3 file in the Important Files section of the MPLAB X IDE project (Figure 2-17). 

FIGURE 2-17: SAVE/LOAD BUTTONS IN MPLAB X IDE

At any time, using the Undo and Redo buttons, located in the MPLAB X IDE toolbar
(Figure 2-18), will undo and redo the settings in the Composer or the Pin Manager
Area. 

FIGURE 2-18: UNDO/REDO BUTTONS IN MPLAB X IDE
 2016 Microchip Technology Inc. DS40001829B-page 22



Operating Areas
FIGURE 2-19: INVALID DATA ENTRY

Additional validation is implemented for areas where text is entered by the user. The 
field will blink on and off until a legal value is entered. In Figure 2-19 the field requires 
a legal “C” identifier.

2.5 MCC OPTIONS

Several aspects of the operation of the MCC can be managed by using the “Options”
panel (Figure 2-20), which can be invoked by clicking Tools → Options →
Embedded → MPLAB Code Configurator in the menu bar of the MPLAB® X IDE.

FIGURE 2-20: MCC OPTIONS PANEL

The MCC Options panel offers the following controls: 

2.5.1 MCC File Handling 

1. Remove unused files from the project: enabling this option tells the MCC to
remove .c and .h files for modules which were removed from the MCC
configuration between the subsequent generation procedures. This option
ensures that the files which are included in the project (and thus in the
compilation) are only those which are strictly necessary. However, this will not
delete the files from the disk. 

2. Delete unused files from the disk: this option gets enabled only when selecting
“Remove unused files from the project”. This performs the additional task of
deleting unused files from the disk and therefore, files cannot be recovered
anymore. 
 2016 Microchip Technology Inc. DS40001829B-page 23



Operating Areas
2.5.2 MCC Dialogs 

1. Always ask before removing a module: enabling this control enables the “Are you
sure?” dialog box which appears while disabling or removing an enabled module. 

2. Always ask before removing a pin: enabling this control enables the “Are you
sure?” dialog box which appears while deallocating or removing a pin from a
peripheral.

2.5.3 MCC Line Endings

Specify the type of line endings to use in the files generated by MCC. The default is 
DOS (<CR><LF>). Unix line endings (<LF>) may be specified.

2.5.4 MCC Libraries

1. Use the Add Library button to add a MCC modular library to the MCC plugin.

2. Use the Open Library Folder button to view the MCC modular libraries folder.
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Chapter 3.  Generating MCC Drivers
3.1 SETTING UP MPLAB X IDE AND LAUNCHING THE MCC

To generate drivers using the MCC in MPLAB® X IDE, follow these steps: 

1. Create a new MPLAB® X IDE project or open an existing project (Figure 3-1). 

2. If multiple projects are open in MPLAB X IDE, set one as the main (active) project
by selecting “Set as Main Project” in the MPLAB X IDE. For the active project,
the MCC automatically includes the generated driver files.

3. Open the MCC plugin tool. For this, in the menu bar of the MPLAB X IDE, go to
Tools → Embedded → MPLAB® Code Configurator v3. Or, click on the MCC
icon in the MPLAB X IDE toolbar. 

FIGURE 3-1: OPENING THE MCC IN MPLAB® X IDE 

Note: For MAC users the “Embedded” selection will be under the “Preferences” 
menu. This launches the MCC GUI.
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3.2 SELECTING AND CONFIGURING MODULES

After opening the MCC, peripheral and library modules can be added to the project.

1. In the Project Resource Area, select the peripheral or library module which
needs to be configured by clicking the module’s name. After a peripheral or
library module is selected for configuration, the configuration GUI for that
peripheral is displayed in the Composer Area. 

2. Configure the peripheral as required for your application in the Composer Area.

3. Configure the pins in the Pin Manager Area depending upon the application
requirements.

3.3 GENERATING CODE

When the MCC Generate button is pressed in the Project Resources window, the listed
actions are performed by MCC. Details of the code generation are shown in the MCC
Output window (Figure 3-2).

1. The MCC configuration file is saved. If this is the first time the MCC configuration
file has been saved, a Save dialog box appears. The user can specify a name
for the MCC configuration or accept the default name MyConfig.

2. MCC generates code for the peripheral or library module if the module’s
configuration has changed since the last time MCC generated code for that
module. 

If MCC attempts to regenerate a file on the disk that has been modified outside of MCC, 
the MCC Merge window is displayed. The MCC Merge window allows the user to select 
whether to keep the modified file (default action), or to replace the modified content with 
the content generated by MCC.

The MCC Merge window is discussed in Section 3.3.2 “The MCC Merge Window”.

FIGURE 3-2: MCC OUTPUT WINDOW

Note: The user can force all modules to be generated by MCC by right-clicking in 
the Project Resources window and selecting “Force Update”, before 
clicking on the Generate button.
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3.3.1 Saving and Loading the MCC Configuration

Saving and loading the MCC v3 configuration is integrated into the MPLAB X IDE Save
and Load functions. The MCC v3 configuration is saved whenever the Generate button
is pressed. The user can also save the MCC v3 configuration by clicking on the MPLAB
X IDE Save tool, or selecting Save from the File menu (see Figure 2-17).

The MCC v3 configuration file is included in the MPLAB X IDE project, under the
Important Files folder. The configuration file uses the extension .mc3. Double-clicking
on the MCC v3 configuration file will cause that MCC v3 configuration to be loaded
(Figure 2-17).

3.3.2 The MCC Merge Window

If any of the files generated by the MCC has been edited outside of MCC and saved to
the disk, then the MCC Merge window will appear in the Composer Area. The MCC
Merge window allows the user to decide whether to keep the edits, or to replace them
with the MCC newly generated code.

When changes have been made both to a generated file and also in the MCC
Composer window, the MCC Merge window shown in Figure 3-3 will be displayed. The
MCC Merge window allows the user to resolve the conflicts between the newly
generated file and the edits the user has made to the file.

When the newly generated MCC content has been accepted by the user, MCC makes
the changes to the file. To the MPLAB X IDE, these changes are the same as if the user
typed in the new content. The normal MPLAB X IDE edit undo can be used in the MCC
Merge operation.

FIGURE 3-3: MCC MERGE WINDOW – FILE LIST

A list of all the files that need to be merged is shown at the top of the MCC Merge
window. The user must select each file in the list, in turn, to ensure that all of the newly
generated code is incorporated into the project.

Note: User edits will never be overwritten by the MCC generated code, except by 
explicit user action in the MCC Merge window.
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At the top of the MCC Merge window, in the center margin, there is an arrow, as shown
in Figure 3-4. Clicking on the arrow will replace all of the user edits in the current file
with the MCC updated code that the MCC has just generated. The numbers above the
arrow indicate the current difference and the total number of differences.

FIGURE 3-4: MCC MERGE WINDOW – REPLACING ALL USER EDITS
WITH MCC GENERATED CODE

The individual lines of MCC Updated Code can be selected to replace the edited code.
As shown in Figure 3-5, clicking on the arrows in the right margin of the left window will
copy the MCC Updated Code to the generated driver file. Once the changes are
accepted the Merge Tool will remove the highlighted file and highlight the next file on
the list. To insure all updates are completed a warning will be generated if the Merge
Tool is closed before all the changes are accepted.

FIGURE 3-5: MCC MERGE WINDOW – REPLACING SINGLE CHANGES
WITH MCC GENERATED CODE

Note: Remember to merge the code for every file shown in the file list in the MCC 
Merge window.

Note: Be sure to save all the changed files from the Merge.
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Chapter 4.  Generated Sources and Header Files

®
The generated drivers will be included in the active MPLAB  X IDE project, as shown
in Figure 4-1.

FIGURE 4-1: GENERATED SOURCE AND HEADER FILES

1. The mcc.h and mcc.c files include the definitions of Configuration bits and the
OSCILLATOR_initializer function. These definitions are based on the settings
which were made for the System module in the Composer. Also included is the
SYSTEM_initializer function which can be called in the application program to
call all the other default initializers (the ones marked in the GUI by sprocket symbol). 

2. The pin_manager.h and pin_manager.c files include the Pin Manager
initializer functions based on the configurations which were made in the Pin
Manager GUI.

3. The interrupt_manager.h and interrupt_manager.c files are optional
files which are generated only when peripheral interrupts are enabled and they
include interrupt initializer functions. 

4. The .c and .h are module specific files and include each module’s
peripheral\library configuration functions. 

5. The main.c file is generated only when the MCC detects that there is no main.c
file present in the project. If there is any previous main.c in the project regardless
of its creator (the user or the MCC), it will not generate or overwrite the existing one.
When using a main.c not generated by the MCC the lines: “#include”,
“mcc_generated_files/mcc.h”, and SYSTEM_Initializer() need to be added to
the main.c file. The main.c file generated by the MCC may include commented
out code lines to enable interrupts. Remove the comments from the appropriate
lines if the application requires interrupts to be enabled when it starts. 
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The Functions provided in any of these MCC generated files can be called from
the user application code, as required. The MPLAB X IDE provides auto-comple-
tion assistance of all of the MCC generated content. While editing source code
in the project, start typing in a MCC API, or MCC variable name, and press
<CTRL+ Space>. The MPLAB X IDE will show a list of options to complete the
entry.
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Chapter 5.  MCC Device Migration
Using a MCC configuration created for one device, on a different device is called MCC
device migration. 

It is possible that attempting to use a MCC configuration on a device other than the one
for which it was created, might appear not to fail. It is wholly the responsibility of the
user to determine if the MCC code generated as the result of device migration is
suitable for use in their application.

Unintended MCC device migration may occur if the selected device in the MPLAB X
IDE project is changed after MCC has been configured for that project. Copying a MCC
v3 configuration file (*.mc3) to another MPLAB X IDE project may also cause MCC
device migration or other unintended operation.

Note: MCC device migration is not supported in MCC.
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